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SYSTEM INFORMATION

TEK-SCOPE is a standalone high definition optical inspection system.
The camera system has the following functions:

e Auto Focus On/Off

e Digital Zoom

e LED lighting with adjustable brightness

e PC Connection Software via DVI / HDMI port

e Video /Image PC Storage Folder

e Measurement & drawing capabilities

TEK-SCOPE can be connected to any monitor with a DVI / HDMI port.

When used with a computer you can install the included TEK-SCOPE Software and make measurement,
drawing and much more.

ASSEMBLY

TEK-SCOPE package includes the following items:

* Inspection system unit

e Remote control

e Power Supply

e Monitor Cable (HDMI — Dvi) - Computer cable (USB — USB mini)
e TEK-SCOPE Software and manual on USB memory stick

1. Use with a monitor:

Place the camera unit on the desired stable location.

Position optional XY table or the tilt table if used.

Connect the monitor to the camera unit (HDMI/DVI) by the monitor cable.
Connect the power supply to a power outlet.

Connect the power supply to the camera unit with the DC cable.

You can now start the system by pressing the button on the top of the camera unit.
If needed, turn the LED lamp on/off by using the button on the back of the unit.

2. Use with a PC:
Connect your computer with the USB cable (USB mini for TEK-SCOPE, USB for computer).
Install the TEK-SCOPE PC software

You can now start the system by pressing the button on the top of the camera unit.
If needed, turn the LED lamp on/off by using the button on the back of the unit.
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1. USE WITH A MONITOR

Remote control
Use the remote control when the device is connected to the monitor.

Z+ Zoomin (+)

Z- Zoom out (-)
» Increase brightness -
< Decrease brightness @

Press MODE shortly and autofocus will go off / on. When autofocus is off, ¢ & » will adjust focus manually.

OK changes magnification to wide angle and shows an artificial laser cross. Press OK again to exit and go back
to previous magnification.

Press MODE for 5 seconds and a menu will appear with more choices (user or service). Press OK for more option
and settings:

e Language

e Camera Resolution

e Brightness / Contrast

e etc.

FUNC changes between color and greyscale. Press MODE again to exit.

Remote control pairing

Hold the remote control on the back of the TEK-SCOPE while the power is on, then press the OK button on the
remote control for 5 seconds. When a red light start flashing, the pairing procedure is complete.

Note: The remote control inside the package is paired by the Factory. Changing batteries or using remote with
more than one device may require additional pairing.
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TEK-SCOPE live streaming
Live streaming on TEK-SCOPE is only possible with a unique connection to a Monitor or to a PC.
The Device cannot work properly if connected to a PC and a Monitor at the same time.

How to set your monitor

1. To pair TEK-SCOPE with the screen you are using: press MODE button on the remote for a couple of seconds
to get into the menu.

Service — Camera — Camera resolution - Choose AUTO DETECT

2. To turn on the on-screen magnification display:

Press MODE button on the remote for a couple of seconds to get into the menu.

User — Zoom OSD Function — Choose ON

Your system is now paired with your screen and the magnification is shown on the screen.

If you are using a Tilt table or any higher object, you should replace the lens to a +4 lens.

You can do it using the removal tool. Clean the lens before using the system to avoid fingerprints etc. Notice that
you also need to change the lens settings in the TEK-SCOPE menu.

Press MODE button on the remote for a couple of seconds to get into the menu.
User - lens — Change to +4 or +3 by using the ¢ » buttons on the remote.
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2. USEWITH A PC

TEK-SCOPE software
Operating System: Windows 10.
After installing the Software, you can access TEK-SCOPE functions:

Toolbar
EIEEEEEEREL e Qiceal-tek 4 B S B CS) (@) (m) 14
Zoom in Freeze Brightness Focus Adjust IR Cut_ Draw/Measure
Y Y ¥ b ¥ ¥

A i A A
Zoom out Save live Picture Autofocus ON/OFF Cross Stop Digital
Mark tool Vertical Draw circle  Angled lines
¥ ¥ L J L
— IPI /
[ I l| [ ] l| I : | :.C: I O [— Y
A " , A
Text Horizontal ~ Free Drawing Draw Rectangle
ZOOM + ,- : camera Zoom Wide ( Decrease ) or TELE ( Increase)
SAVE : left Click to save live picture, choose location folder and name.

Right click on this button will start and save the video. To start the video right click once;
to end the video right click once again. (Codec needs to be installed)

FREEZE : live picture will freeze, press the same button to go back to live again

BRIGHTNESS : increase or decrease brightness of the live image

AF ON/OFF : autofocus ON or OFF. When “off” it is possible to adjust manual focus with the ¢ » | this can
be useful if the object under the camera has different heights

CROSS : a cross devides the monitor in 4 parts

IR CUT : change to greyscale, it helps camera if used with IR light

STOP : turns off digital Zoom

DRAW/MEASURE : to activate text, drawing and measuring functions (buttons on the right of the screen)
TEXT : set some texts into the drawing, max 84 characters. Black text on white background
MARKTOOL : set spots on the drawing, for soldering marking, the size follows magnification
HORIZONTAL : horizontal measure, straight lines

VERTICAL : vertical measure, straight lines

FREE DRAWING : free drawing

CIRCLE : draw circle (2 options)

RECTANGLE : draw rectangle

ANGLED LINES : measure in non-horizontal or vertical mode. ( 2 options)
MOUSEWHEEL : up /down to handle Zoom in/out

WIN-CTRL-N :information about the software version

MOUSE LEFT CLICK : save images
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System set up

Example of system setup when TEK-SCOPE Software is used:

Suggested:
Monitor with 1920x1081
resolution,

Press Win-P to change
outout from PC 1o
connected monitor.
Use ONLY 2:nd screan,
{ Not dual or extended)

LISB FROM CAMERA

o
ﬁ%ﬁ CEE] EEEE] EEEE a8 1 ¥ ¥
e .ju LS B 2
Ii"‘l' L == S ]
.I J-'u-'h-lla—.l = n.m..l-n-ln_.

T _A_ =
|. EEr) «_l_l_l " |.1.L

DO NOT CONNECT THE DEVICE BOTH TO A MONITOR AND PC TOGETHER.
If the computer and the monitor are used together, like extended or dual, the algorithm for magnification/
measuring will be effected.

With the following screens sizes: 207(1600x900); 227”(1920x1080); 22”(1680x1050); 24”(1920x1080);
24”(1920x1200) measuring will have a tolerance of 1-2% without calibration.

Measuring

Put your object under the camera.

Choose the magnification by the software buttons.

Notice: using the remote control, the Zoom factor will be not updated and measuring will be wrong.

DO NOT USE REMOT CONTROL WHEN CONNECTED TO THE PC BUT USE THE SOFTWARE TOOLBAR.

Press the draw button ]E Press LB (Left button) on your mouse, select the horizontal |E or vertical |[[ button
and click the starting point. Then go to the second measuring point and press LB on your mouse. The measure
value will appear on the screen.

Calibration

If you need a more accurate measuring, the calibration should be done.

Put a ruler horizontally on the subject you wish to measure. Verify that your magnification is the one you want,
select the drawing mode ]E right click on the mouse and select “calibration”. A message box will appear, telling
if you can use 1 mm or 10 mm calibration. The calibration setting (1mm or 10mm) depends on the magnification
you use. Press the LB on your mouse to select the length of 1mm or 10 mm. A yellow line will confirm the length
you selected. You can repeat it: just press the draw mode twice and start again.
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Favorite calibrations
If it is a repeating task, you can save your settings. In Draw mode ]E click RB (Right Button) and select “File”

File > Save Settings
Colors » Open Settings

Save setting, choose a file name and a folder. Your calibration and magnifying values will be saved and could be
used again. Press the OK button with mouse and don’t use the enter key.

Save drawing

Right click also has the functions to save the drawing. You can choose the name and the folder to save your
picture.

Change colors
If you wish to change the color of your drawing lines, right click and choose colors.
The active color will be indicated as (Active).

Colors > RED (Active)
Calibration GREEN
BLUE

Angle
Option 1, shows length and angle vs the horizontal.
Option 2, right click and select angle vs line.

Diameter

Default:

Option 1: click the circle button and click two points of the round subject. A circle will show diameter and radius.
Option 2: right click, select “Diameter” and then “Diameter draw”, press left button and move the mouse.

Press ¥ to get an aiming start point, release ¥, repeat if needed. Then press Left button move the mouse and
release.

Lens

First time the Software is started, it will have a default value for the lens that is set to have a +3 lens. If you use
the +3 lens, nothing need to be done.

If the +4 lens is used (with tilt table) do as follows: start the program, right click in the live image and choose lens,
change to lens +4. Done.
Next time the software will be started, it will remember this setting.

If lens it changed time to time, user needs to change the lens setting.
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Save images as sequential

By default images are saved as Index = year_Month_day_Hour_Minute_Second.
Example 170823_11.07.04
This can be changed by right click in the live image

Image Sequential =image name will be Noname_1 and added to the index of every saved image.
Example, NoName_1, Noname_2, Noname_3 ......

Set name for Image Sequential = choose the name of the image and the index will be added.
Example = MyBoard_1, MyBoard_2 ....

Reset index = the value after the name will be set to 1 again, Name will remain until user
changes it.
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Save video installation encoder

A 3part encoder needs to be installed onto the PC.
Available on the installation under folder \encoder. Run the setup .
Then go to Encode settings, ( program Xvid)

L ¥ond
£ Check for Updates
4 Confegure Decoder
#< Configure Enco der

—

L] Release Notes [ e eneon
#% Uninstall Xoid Video Codec =1
2 Hvid Homepage
i i MiniC omert
). Advanced
reve  EE—] - |
Fardg w e 3] |
T e | = L]
Nt e | Chose "other options”
Change general purposet to
i s Real-Time.
Lty [F—rre— =] -
e e 7 Chose "Display endocing status”

Unmarkt the Display encoding status

T Pt g s o s bms
[ Vg amsmng s

L mm

Installation of decoder is now finished.

Verify that there is a folder named “\ Focus” under \\my pictures. If not, make a new folder and name it Focus.
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OPTIONAL ACCESSORIES

TEK-TILT 360° Inspection Table

Maneuverable tilting table provides perfect object alignment. The table plate is covered with an ESD-safe material.
The 4D lens is included to replace standard TEK-SCOPE lens.

Diameter: 220 mm; Height: 50 mm

TEK-XY Inspection table
Portable XY ESD safe table for easy control of magnified object.
Horizontal Movement: 190mm; Vertical Movement 235 mm; Table Dimension: 420x410 mm; Weight= 4.5 kg

TEK-DBOX Image capture box

When using TEK-SCOPE without a computer you can save images directly on USB Pen, using the Image capture
box.
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TEK-DBOX installation

Connect the unit as showed below. Check the IN and OUT label on the box.

IN: connect the HDMI cable
to TEK-SCOPE

OUT: connect the HDMI
cable to the monitor

(. www.ldeal-tek.com

Connect MINI USB
OUT: Connect your USB

power cable flash drive or SD card
TEK-DBOX BLUE LED: TEK-DBOX RED LED:
Power On Recording / Snapshot

To control TEK-DBOX use the remote control.

1. Click on HDMI button to select HDMI output: the Green LED goes ON and
steady.

2. Select OUTPUT RESOLUTION preferences: 720p or 1080p.

3. RECORDING: Click on REC/STOP button to start and stop the recording
session.

4. SNAPSHOT: Click on SNAPSHOT button to take a instant picture.

All Videos and Pictures will be save onto the USB flash drive.
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TECHNICAL FACTS

Magnification 20” monitor: 2 - 300x digital; 20/-30 optical
Autofocus and manual focus

Focus area 80 mm

Free working distance under camera - 280mm
Resolution: FHD on monitor, HD on computer
On screen magnification rate

Frame rate 60 Hz

Output HDMI / USB

Effect 29 W

LED light 12 V

Weight 4,5 Kg

TEK-SCOPE Software

SAFETY INFORMATION

Never connect the product if it has been exposed to moisture.
Avoid pinching power cord.

If the product is moved from cold to warm, condensation may occur. Wait about 30 minutes before using the
product.

Use TEK-SCOPE only on stable work surface, with at least 45 cm depth.
If normal functions can’t be reset after troubleshooting, turn power off and contact your local supplier.

WARRANTY

1 year warranty for manufacturing defects.

CONTACT

Ideal-tek SA

via Motta 4

6828, Balerna - Switzerland
phone: 0041 91 683 3229
email: info@ideal-tek.com
www.ideal-tek.com
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